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1 About This Document

This document describes the reference design for Flexibilis Redundant Switch (FRS) [8]. FRS
is an Ethernet switch Intellectual Property (IP) core targeted at programmable hardware
platforms. The purpose of the Reference Design is to provide an FRS evaluation platform and
it may be used as is or modified as required. The Reference Design implements a HSR/PRP
RedBox with support for 1588 PTP ordinary and transparent clocks. The Reference Design is
provided for Cyclone IV GX, Cyclone V GX and Cyclone V GT evaluation boards and it is
downloadable from Flexibilis website www.flexibilis.com. There is also a Reference Design for
Cyclone V SoC evaluation board but it is not covered by this document.

Chapter 2 describes the Reference Design in general. Chapter 3 describes the FPGA part of
the Reference Design, i.e. VHDL, IP and QSYS issues. Chapter 4 describes the software
included in the Reference Design. Chapter 5 contains abbreviations and chapter 6
references.

1.1 Conventions Used in This Document

Register descriptions in this document follow these rules: Unless otherwise stated, all the bits
that activate or enable something are active when their value is 1 and inactive when their
value is 0. The explanation of the bit types is the following:

RO = Read Capable Only. The bits marked with RO can be read. Writing to these bits is
allowed if not otherwise stated. If writing is allowed, it does not affect the value of the bit.

R/W = Read and Write capable. The bits can be read and written. Writing 1 to the bit makes
its value 1. Writing 0 to the bit makes its value 0.

R/C = Read and Clear capable. The bits can be read and cleared. Writing 0 to the bit makes
its value 0. Writing 1 does nothing.

R/SC = Read and Self Clear. The bits can be read. After reading bits, the value automatically
returns back to 0.

R/W/SC = Read, Write and Self Clear. The bits can be read and written. Writing 0 to the bit
does nothing. Writing 1 to the bit makes its value 1 for a while, but after that the value
automatically returns back to 0.

The bits marked as Reserved should not be written anything but 0, even if they are marked as
read capable only, because their function may change in future versions.

Bit and byte order used for 16, 32 and 64 registers is depicted in Figure 1. Leftmost byte is in
the lowest address.

Bit 15 8 7 0
16bit Bus
or Byte 1 Byte 0
Register:
MSB LSB
Bit 31 24 23 16 15 8 7 0
32bit Bus
or Byte 3 Byte 2 Byte 1 Byte 0
Register:
MSB LSB
Bit 63 56 55 48 47 40 39 32 31 24 23 16 15 8 7 0
64bit Bus
or Byte 7 Byte 6 Byte 5 Byte 4 Byte 3 Byte 2 Byte 1 Byte 0
Register:
MSB LSB

Figure 1. Bit and Byte Order

Signal names are written in document with signalName style. Block names are written with
Capital first letter. Pseudo code is written with PseudoCode style and command line
commands are written with CommandLine style.

Specification 6 (34) Version 1.1
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2 General

The FRS Reference Design consists of FPGA and SW design. The SW is run on NIOS2
softcore processor. The FPGA design is implemented using Altera QSYS tool that provides a
graphical design tool for FPGA systems. FPGA design compilations are made using Altera
Quartus Il tool and the SW is compiled using Altera NIOS Il EDS. Version information about
the tools used, the IP blocks and the SW components are listed in the Reference Design
release notes included in the release package.

Specification 8 (34) Version 1.1
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3 FPGA Reference Design

The VHDL and QSYS part of the design is described in this chapter.

3.1 Top Level

The Reference Design block diagram with external interfaces is described below. There are
some differences between the Cyclone IV GX (C4GX), Cyclone V GX (C5GX) and Cyclone V
GT (C5GT) designs, but mainly the designs are the same.

Evaluation Board

User LEDs (Onboard)
0 User DIP Switches (Onboard)
PLLs User Push-Buttons (Onboard)
3x12C

FPGA
FRS Reference Design

PPS Output (SMA)

RGMII
Oscillator and ,
PHY BEECEE T ‘ Reset Push-Button ‘
STA MDIO
LCD ‘ LCD ‘

XR7_softsoc (QSYS)
Flash ) ‘ Flash ‘

Pin header ‘ < MMD MDIO
Authentication ) ‘ Pin header

Figure 2. Reference Design Block Diagram

The Reference Design provides the following interfaces

3 x SGMII interface for fiber and copper SFP modules. (1000BASE-X and SGMII)
o Redundant Port A
o Redundant Port B
o Interlink
RGMII interface for onboard PHY
MMD MDIO/MDC for FRS management. Routed to external pin header (if available)
STA MDIO(MDC for PHY management)
12C interfaces for SFP module management
LCD interface
o C4GX and C5GX have identical LCD command interfaces. For C5GT the
interface is 12C.
Authentication, routed to external pin header (if available)
o Not available in C5GX. The design will function for 2 hours.
o Note that the Authentication chip [12] is not on the evaluation board (C4GX,
C5GT). Without external security chip the design will function for 2 hours
Flash for FPGA configuration
Push-buttons and DIP switches
User and Link LEDs
Clocks and reset
o C4GX
= 50 MHz, clk
e Routed through PLL to LCD clock
¢ Routed directly to QSYS design (xr7_softsoc)
= 125MHz, eth_clk
e Routed through PLL to 125MHz and 25 MHz Ethernet clocks
for RGMII
¢ Routed directly for SerDes
o C5GX
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50MHz, clk
e Routed through PLL to LCD clock
¢ Routed directly to QSYS design (xr7_softsoc)
125 MHz, eth_clk
e Routed through PLL to 125MHz and 25 MHz Ethernet clocks
for RGMII
156.25 MHz, serdes_clk
e Routed through PLL to SerDes

50MHz, clk
¢ Routed directly to QSYS design (xr7_softsoc)
125 MHz, eth_clk
e Routed through PLL to 125MHz and 25 MHz Ethernet clocks
for RGMII
156.25 MHz, serdes_clk
e Routed through PLL to SerDes

The top level design as defined in fpga.vhd includes:

- PLL for LCD clock (in C4GX and C5GX)
- PLL for RGMII clocks

- PLL for Serdes Clock (C5GX and C5GT)
- Clock Control for RGMII clock selections
- QSYS design called xr7_softsoc

3.2 QSYS Design

The QSYS design, xr7_softsoc, is a combination of many QSYS components and their sub
components. The block diagram below describes the QSYS system in the highest level and
clock, reset and Avalon routing.

Specification
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Sys ID

I PIO PB {«———Push-Buttons
PIO Reference Design
Version
] PIO DIPSW «—DIP Switth———
-« 1CD——p LCD z
— £ PIO LED LED—»
[e) N
z [
4——MDIO———
ETH MDIO o
- MDC—— PIO Control CTRL———»

-4———MMD MDIO——— | MDIO to Avalon

Timer

NOIVAY
\

4—SGMI—p~
4 Link LED———— FRS Redbox

Serdes CLK and reset——m» Tri-State Bridge l—— Flash——
44— SGMI——p

Flash Controller

Serdes CLK and reset——m

< ROMI——————» 2
PIO (12C) — §

-4—— Authentication——————| 12—

12C——

4——2C——

JTAG (UART)

50 MHz and reset————m clk_50

125 MHz and reset————m» clk_125 Onchip Memory

25 MHz and reset————m» clk_25

2 MHz and reset——m»|  clk_lcd (not in C5GT) L__| (NIOS_JTAG_DEBUG)

Figure 3. XR7_softsoc Design Block Diagram
XR7_softsoc includes the following components:

1. Clock and reset for 2MHz (LCD), 25, 50 and 125MHz.
a. Clock source components are used in QSYS designs to feed clock and resets
into the QSY'S system/components
2. FRS RedBox
a. More detailed description in the next chapter
3. MDIO to Avalon Bridge
a. Provide method for the MMD MDIO to access Avalon. For more info on
MDIO-to-Avalon Bridge see FRS User Manual Appendix “MDIO-to-avalon
Bridge” [8].
b. Provide bridge between MMD MDIO and STA MDIO. However, in Reference
Design the NIOS is controlling the STA MDIO and there is no access from
MMD to STA MDIO.
c. Provide automatic PHY status polling functionality

4. ETH MDIO
a. Provides MDIO/MDC interface for NIOS. Used to configure external RGMII
PHY.
5. LCD

a. Provides LCD interface

b. In C5GT the block is 12C
6. Reference Design Version

a. Includes Reference Design version number
7. SYSID

a. Includes System ID
8. NIOS Il Soft processor core

a. Includes also JTAG debug module
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9. Onchip memory
a. Onchip memory is used for SW and for AFEC TX and RX buffers
10. JTAG Uart
a. Enables NIOS SW debugging
11. 12C
a. Actually a Parallel IO block (P1O), used to generate 12C interface
12. Flash Controller
a. Configuration Flash controller
13. Timer
14. PIO Control
a. Control signals, currently only PHY Reset
15. PIO LED
a. Control LEDs
16. PIO DIPSW
a. User DIP switch signals
17. PIO PB
a. User Push-Buttons

3.2.1 FRS RedBox

The FRS RedBox QSYS component is actually a subsystem i.e. it includes other QSYS
components. It is generated based on configurations with tcl scripts, which can be found in
the FRS RedBox component folder. The FRS RedBox component block diagram with current
configurations is presented in Figure 4.
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FRS Redbox
FRS
-t uthenticatior——
Reconfig
A
IR IRQ Bridge IRQ———
- TX/RX Buffers P AFEC d M| Port0
-t »
-t L
-4———SGMII/1000Base- P
ase-x SGMII1000Base-X | M|
- Link LED————— Port1
———Serdes CLK and reset - ALTTSE |t >
t——SGMII/1000Base- Avalon
i ase X1 SGMI1000Base-X | GMIl-»] Pt P—Avalon A
- Link LED———]— Port2
— 1 Serdes CLK and reset——| ALTTSE | > LA\/alon B———
-Timed FRTC |«
~4——SGMIV000Base-x—"B iy1000maseX | M
- Link LED———]— Port3
— ALTTSE |-
——t——Serdes CLK and -~ l g
erdes and reset Switch —
Splitter
- RGMI—— -t GMI—p|
— CLK and reset———m»| RGMII <} L Port4
- Link LED———
——25MHz and reset——— MII CLK AVALON
——50 MHz and reset——— Avalon CLK
———125 MHz and reset————m| System CLK
——r—Reconfig clk and reset——m»=~  Reconfig CLK
Figure 4. FRS RedBox Component Block Diagram

FRS QSYS component is the Ethernet switch core, supporting 3-8 ports, HSR/PRP protocols
and 1588 TC functionalities [8]. It can be instantiated also in QSYS as a separate component
“Flexibilis Redundant switch” or in the VHDL code.

AFEC

Advanced Flexibilis Ethernet Controller (AFEC) acts as an Ethernet Controller for the NIOS.
More info on AFEC can be found in the AFEC user Manual [7].

SGMII/1000BASE-X

SGMII/1000BASE-X adapters provide interface conversion between GMII (FRS) and
SGMII/1000BASE-X. This component includes Altera Triple Speed Ethernet (ALT_TSE) IP,
which is used in “PCS only” mode. For ALT_TSE configuration refer to the ALT_TSE user
guide [1].

RGMII
RGMII adapter provides interface conversion between GMII (FRS) and RGMII.

RECONFIG

Since the design implements Transceivers in the SGMII/1000BASE-X adapter, this block is
required to be instantiated. Currently it does not include any functionality.

FRTC

Flexibilis Real Time Clock provides time information for FRS. FRTC can be controlled via
Avalon.
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IRQ BRIDGE
IRQ Bridge component provides a QSYS supported method for interrupt mapping.

CLOCK SOURCES

FRS RedBox component includes four clock source components (mii_clk, avalon_clk,
system_clk, reconfig_clk ), that are used to map clock signals into QSYS components.

AVALON ARBITER

The Avalon Arbiter is able to provide arbitration functionalities for two different Avalon
masters. In this case the masters are

- MDIO-to-Avalon bridge
- NIOS

AVALON SPLITTER

The Avalon Splitter component is generated automatically by the QSYS to support older FRS
control mechanisms, even though it would not be required in this case.

3.3 FRS RedBox Configuration

This chapter describes how FRS RedBox component is configured and how configurations
affect the actual design.

To ease the configuration, instantiation and mapping of VHDL designs, the QSYS component
provides automatic component and signal mapping and instantiation based on the
configuration made in QSYS GUI.

Specification 14 (34) Version 1.1
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3.3.1 Generic Configuration

|" FR5 IP core variation

FRS IF core variation: :Fp_s (with SecIP interface) -

* FRS Redbox customization

Generics | Interface options | Interface mnﬁguraﬁun|

RST_ACTIVE: i
FES_PORT_HIGH: P
PORT_STATE_DEFALLT: |7a5
HSR_PORT_OFT: 5
HSR_PORT_A: i
HSR_PORT_B: 2
HSR_PORT_C: 3
CFG_CLK_FREQ: 175
AVS_ADDR,_MSE: 21

GXE_CHAMMEL_OFFSET: |
DEVICE_FAMILY: Cydaone IV GX

Figure 5. Generics

FRS RedBox Generics configurations page is shown in Figure 1, with settings used in this
case. The configurable generics are:

- FES_PORT_HIGH
o Sets the port count. Value 4 means that there are five ports.
- PORT_STATE_DEFAULT
o Sets the default value for all PORT_STATE registers. Value 288 is 0x0120,
which sets ports to forwarding mode, GMII and 1000Mbps
- HSR_PORT_OPT:
o Setting ‘0’ would allow redundant functionality in any port.
o Setting ‘1’, would allow redundant port capabilities only in two certain ports.
o Setting ‘2’ allows redundant functionality in three ports
o Setting ‘3’ would disable redundant features
- HSR_PORT_A
o IfHSR_PORT_OPT = ‘1’ then this setting determines the port for HSR_A
port. In this case HSR_A is set to port 1.
- HSR_PORT_B
o IfHSR_PORT_OPT = ‘1’ then this setting determines the port for HSR_B
port. In this case HSR_B is set to port 2.
- HSR_PORT_C
o IfHSR_PORT_OPT = ‘2’ then this setting determines the port for the
HSR/PRP interlink port. In case HSR_C is set to port 3
- CFG_CLK_FREQ
o This defines the system clock frequency for the FRS and it must be set to
match the actual clock frequency. In this case it is 125 MHz
- AVR_ADDR_MSB

Specification 15 (34) Version 1.1
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o Sets the Avalon address bus width. As a MSB definition it is actual width
minus one.
- GXB_CHANNEL_OFFSET
o Not applicable since only one FRS is instantiated inside one FPGA chip.
o In case there would be multiple FRS inside one FPGA, the
GXB_CHANNEL_OFFSET needs to be individual for each.

3.3.2 Interface Options

|' FRS5 IP core variation

FRS IP core variation: :Fp_s (with SecIP interface) -

[* FRS Redbox customization

Generics | Interface options | Interface mnﬁguraﬁun|

Enable avalon slave A interface
Enable avalon slave B interface
[] Enable speed interfaces

Enable authentication interface

[] Enable external transceiver reconfiguration interface

Figure 6. Interface Options

In the Interface Options page, Figure 6, it is possible select what interfaces FRS RedBox
provides. In this Reference Design Avalon A and B as well as Authentication interfaces are
provided. Avalon A interface is used by the NIOS to access component registers on the
Avalon bus. Avalon B is connected in QSYS to the MDIO-to-Avalon bridge. It is not
recommended to change these settings without understanding what each setting actually
does.

3.3.3 Interface Configuration

In the Interface configurations page there are three sub pages.

3.3.3.1 Port Interface Type

Specification 16 (34) Version 1.1
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~ FRS IP core variaktion

FRS IP core variation: :Fp_s (with SecIP interface) -

|~ FRS Redbox customization

| Generics | Interface options | Interface configuration

Select time component: [FpTe

FRTC base address | gy 100000

Enable pps interface

Port interface type | Port base address | Adapter base address

Part Ointerface type  : [aFpc -
Port 1interface type -SGMIHIDUUBESE-K -]
Port 2 interface type -SGMIHIDUUBESE-K - ]

Port 3interface type -SGMIIIIDUUBESE—!{ -]
Fort 4interface type  : [pom

Figure 7. Interface Configurations
The Port Interface type, Figure 7, is used to select interface type for each port. In this case:

- Port0is AFEC i.e. it used by the NIOS
- Port1, 2 and 3 are SGMII/1000BASE-X
- Port 3is RGMII

Other possible interface types include:

- GMII/MII PHY mode
o Provides interface, which is compatible with most PHY interfaces
- GMII/MII Native (None)
o Provides FRS GMII interface without modifications
o Mainly for internal use i.e. QuadBox
- 1000BASE-X only
- 100BASE-FX
- EMAC (Altera’s Ethernet Media Access Controller)

EMAC is used in Cyclone V SoC designs.
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3.3.3.2 Port Address Configuration

|' FRS IP core variation

FRS IP core variation: | FRS (nith SecIP interface) v

|~ FRS Redbox customization

| Generics | Interface options | Interface configuration |

Select time component: |FrTE -
FRTC base address : gk 100000

Enable pps interface

| Portinterface type | Port base address | Adapter base address

Port 0 avalon base address (= MDIO base address) gy 120000
Port 1 avalon base address (= MDIO base address) : |gw040000
Port 2 avalon base address (= MDIO base address) @ | gwosooon
Port 3 avalon base address (= MDIO base address) : |gw0s0000
Port 4 avalon base address (= MDIO base address) : |gwo70000
Switch avalon base address (= MDIO base address) @ |gyw010000

Figure 8. Port Address Configurations

Port base address configuration, Figure 8, defines the Avalon address offset from FRS
RedBox base address for FRS Port and Switch configuration registers. Avalon address map
is defined in Chapter 3.6.
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3.3.4 Adapter Address Configuration

|"’ FRS IP core variation

FRS IF core variation: | FRS (with SecIP interface) .

[* FRS Redbox customization

| Generics | Interface options | Interface configuration |

Select time component: |FrTC ]
FRTC base address @ |gyx100000

Enable pps interface

| Port interface type | Port base address | Adapter base address

Port 0 adapter avalon base address (= MDIO base address) : |qwoaooon

Part 1 adapter avalon base address (= MDIO base address) : |gw020200
Port 2 adapter avalon base address (= MDIO base address) : |qxo20400
Port 3 adapter avalon base address (= MDIO base address) : |qwn20800
Part 4 adapter avalon base address (= MDIO base address) : |gw020800

Figure 9. Adapter Address Configurations

Figure 9 presents adapter base address configuration, which defines the Avalon address
offset from the FRS RedBox base address for adapter registers. Avalon address map is
defined in Chapter 3.6.

3.4 MDIO-to-Avalon Bridge Configuration

Also the MDIO-to-Avalon Bridge QSYS component (Figure 3) provides certain configurations
for the user.
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* Generics
RST_ACTIVE: i

MDIO_PHY_ID:  |pw00000000
PORT_HIGH: 3

MDC_DIV_MSBE: g
DEVICE_FAMILY: [Cyclone Iv GX

|' Configuration signals
CFG_PHY_ADDR: |gx00000000

[* Options

Enable speed interface

| Enable mmd_mdio and avalon master interface
Enable mmd_mdio tri-state buffers
Enable sta_mdio interface

Enable sta_mdio tri-state buffers

Figure 10. MDIO-to-Avalon Bridge Configurations

Figure 10 presents MDIO-to-Avalon Bridge configurations page with settings used in this
case. Configurable generics are:

MDIO_PHY_ID
o This is used in the MDIO-to-Avalon Bridge register PHYIDR1/2 [8]. This is set
to 0x0 by default.
PORT_HIGH
o This setting defines the amount of FRS Ports accessed through MDIO-to-
Avalon Bridge. Value 0 means one port, value 1 means two ports etc.
MDC_DIV_HIGH
o Clock divider for the STA MDC. With this setting the MDC frequency is
1.56MHz since the basic clock is 50 MHz (Avalon) and it divided with 25 (50
MHz / 25 = 1.56MHz)
CFG_PHY_ADDR
o This defines which PHY Addresses are used by external PHY devices. Bit 0
refers to PHY address 1, bit 1 to PHY address 2 etc.. When bit is set to ‘0’, it
is not used by external PHY. In this case none of the PHY addresses are
reserved for External PHYs since NIOS is used as the master on the STA
MDIO via MDIO Controller block as illustrated in Figure 3.
o When polling functionality is enabled, addresses that have been set to ‘1’
cannot be accessed from the MMD MDIO.
Enable Speed interface
o Speed interface is used to notify speed polling status for the FRS. In this
Reference Design the PHY polling is not used.
Enable mmd_mdio and Avalon master interface
o Enables possibility to access Avalon (FRS RedBox) from the mmd_mdio
Enable sta_mdio
o Enables possibility to access sta_mdio through mmd_mdio. However, in this
case NIOS is connected to the STA so there is no need for this interface.
Enable tri-state buffers
o Enable tri-state buffers inside the FRS RedBox.
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3.5 Interface Adapters

Interface adapters are used with FRS to provide other Ethernet interface types than the FRS
native MII/GMII. Figure 4 illustrates the Adapters used in this Reference Design. However, the
FRS RedBox provides also other interface adapters as mentioned in chapter 3.3.3.1.

Some of the adapters include registers for configuration and status. Chapters below define
these registers.

3.5.1 SGMII/1000BASE-X

ALT_TSE is Altera’s IP that implements 1000BASE-X/SGMII PCS. For more information, see
ALT_TSE user guide [11].

Address Register Description
0x0000 ID Reset: 0 x XX B2
Id and version are present in this register
Bits 7-0: | RO Id (0xB2)
Bits 15-8: | RO Version
0x0001 LINK_STATUS Reset: 0 x 00 00
Link status register
Bit 0: | RIW Link status. Must be updated by the user
0 = link down
1= link up
This link status info is used only for link LED
enable.
Bits 15-1: | RO Reserved
0x0002-0x001f RESERVED Reset: 0 x 00 00 00 00
Bits = 150: RO  Reserved
0x0020-0x003f ALT_TSE_PCS Altera's Triple Speed Ethernet IP PCS configuration address space. See
Table 6-9in [11].

Table 1. ALT_TSE Adapter Configuration Registers

3.5.2 1000BASE-X

1000BASE-X adapter implements 1000BASE-X PCS. It can be used instead of ALT_TSE
adapter. 1000BASE-X adapter includes Altera’s IP; ALTGXB for Cyclone IV and Custom PHY
for Cyclone V.

Address Register Description
0x0000 ID Reset: 0 x XX B3
Id and version are present in this register
Bits 7-0: | RO Id (0xB3)
Bits 15-8: | RO Version
0x0001 LINK_STATUS Reset: 0 x 00 00
Link status register
Bit 0: i RO Link status. Informs 1000BASE-X link status.
0 = link down
1= link up
Bits 15-1: | RO Reserved

Table 2. 1000BASE-X Adapter Configuration Registers

3.5.3 100BASE-FX

100BASE-FX adapter implements 100BASE-FX PCS and includes Altera’s IP; ALTGXB for
Cyclone IV and Native PHY for Cyclone V.
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Address Register Description
0x0000 ID Reset: 0 x XX B3
Id and version are present in this register
Bits 7-0: ¢ RO Id (0xB4)
Bits 15-8: | RO Version
0x0001 LINK_STATUS Reset: 0 x 00 00
Link status register
Bit 0: | RO Link status. Informs 100BASE-FX link status.
0 = link down
1=link up
Bits 14-1: | RO Reserved

Table 3. 100BASE-FX Adapter Configuration Registers

3.5.4 GMII

GMII adapter implements GMII to GMII conversion i.e. makes GMII interface suitable for most
PHYs.

Address Register Description
0x0000 ID Reset: 0 x XX B3
Id and version are present in this register
Bits 7-0: | RO Id (0xBO)
Bits 15-8: | RO Version
0x0001 LINK_STATUS Reset: 0 x 00 00
Link status register
Bit 0: : RO Link status. Informs GMII link status.
0 = link down
1= link up
Bits 14-1: | RO Reserved
Bits 15-1: | RW Link Status PHY. Link status is provided for
this block via link status signal.
0 = Not available. Link status is up
by default.
1 = Available
0x0002 TX_CLK_MUX Reset: 0 x 00 00
Link status register
Bits 1-0: | RW Transmit Clock selection.
0X =125 MHz
10 = 25 MHz
11=2.5MHz
Bits 15-2: | RO Version
Table 4. GMII Adapter Configuration Registers
3.5.5 RGMII
RGMII adapter implements GMII to RGMII conversion.
Address Register Description
0x0000 ID Reset: 0 x XX B3
Id and version are present in this register
Bits 7-0: | RO Id (OxB1)
Bits 15-8: | RO Version
0x0001 LINK_STATUS Reset: 0 x 00 00
Link status register
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Bit

Link status. Informs RGMII link status.
0 = link down
1=link up

Bits

2-1: | RO

Auto-negotiation result for speed
00 = Unknown
01 = 1000 Mbps
10 = 100 Mbps
11 =10 Mbps

Bits

15-3: . RO

Reserved

Table 5. RGMII Adapter Configuration Registers

3.6 Avalon Address Map

The Avalon Address Map is based on the settings in QSYS and its components. The Table 6
below defines the Address map for this Reference Design.

Component

BUS and Base Address

Data

Instruction

AFEC TX/RX
Buffer

JTAG, debug on NIOS

0x0404_0800

0x0404_0800

JTAG, Uart

0x0400_0010

Onchip Memory

0x0500_0000

0x0500_0000

0x0500_0000

12C_interface_0

0x0400_0100

12C_interface_1

0x0400_0140

12C_interface_2

0x0400_0180

12C_interface_3

0x0400_01c0

Flash

0x0000_0000

0x0000_0000

Sys ID

0x0400_0000

LCD (Clock Crossing)

0x0700_0000

Timer

0x0400_0080

PIO LED 0x0400_0040
PIO DIPSW 0x0400_0420
PIO PB 0x0400_0400
PIO REF. Design
version 0x0400_00c0
PIO CTRL 0x0400_0440
ETH MDIO 0x0400_0300
FRS RedBox 0x0600_0000
Switch
Switch registers 0x0601_0000
TS 0x0601_1000
VLAN 0x0601_2000
FRS Port 0
GEN 0x0612_0000
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FRS Reference Design
Component BUS and Base Address
HSR 0x0612_1000
PTP 0x0612_2000
CNT 0x0612_3000
IPO 0x0612_4000
FRS Port 1
GEN 0x0604_0000
HSR 0x0604_1000
PTP 0x0604_2000
CNT 0x0604_3000
IPO 0x0604_4000
FRS Port 2
GEN 0x0605_0000
HSR 0x0605_1000
PTP 0x0605_2000
CNT 0x0605_3000
IPO 0x0605_4000
FRS Port 3
GEN 0x0606_0000
HSR 0x0606_1000
PTP 0x0606_2000
CNT 0x0606_3000
IPO 0x0606_4000
FRS Port 4
GEN 0x0607_0000
HSR 0x0607_1000
PTP 0x0607_2000
CNT 0x0607_3000
IPO 0x0607_4000
Adapter PO
AFEC 0x060A_0000
Adapter P1
SGMII/1000BASE-X | 0x0602_0200
Adapter P2
SGMII/1000BASE-X | 0x0602_0400
Adapter P3
SGMII/1000BASE-X | 0x0602_0600
Adapter P4
RGMII 0x0602_0800
FRTC 0x0610_0000
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3.7 Compilation

This chapter describes shortly the Reference Design compilation steps. For more detailed
information about Quartus, please refer to the documentation available in Altera’s website.

The Reference Design package includes ready-to-use program files, so compilation is not a
mandatory step.

3.7.1 Folder Structure

The Reference Design folder structure is illustrated in Figure 11. The fpga folder includes
bin_gsys folder, which includes most of the quartus project files. In addition there is an ip
folder, which includes QSYS component files. The FPGA project expects that external and
encrypted_ip folders are in place and have the correct content. Therefore the user should
place separate FRS, FRTC and AFEC IP cores into the correct folders or change the file path
settings in Quartus project accordingly.

FRS Reference Desing

- Cyclone<Device>devkit_softsoc
> external
> AFEC (To be added)
-2 FRTC (To be added)
> fpga
- bin_gsys
> ip
- bin
- script
> sw
- encrypted_ip
FRS files

Figure 11. Folder Structure

3.7.2 QSYS Generation

The Reference Design includes xr7_softsoc.qgsys file, which includes information about the
QSYS system used in this design. The QSYS system needs to be generated before the first
compilation is done, since the QSYS result design files are not included in the package. Also,
the QSYS system needs a regeneration if something in the QSYS system is changed or the
source codes of the QSYS components are modified.

QSYS is opened from Quartus. First, open the cyclone<Device>devki.qpf (Quartus Project

File) with quartus. Then on the toolbar open the QSYS N . Once QSYS opens, it will query
the gsys system file to be opened. This is the xr7_softsoc.qsys file that is located in the
bin_gsys folder. Once correct system has opened the user can either make changes or then
directly generate a new gsys design. Generation is activated from the Generation page,
pressing the Generate button. There should not be any errors or warnings during the
generation. Once generation has finished, all necessary files have been generated and user
can return to the Quartus project.

3.7.3 Quartus Project

The quartus project is configured with the correct assignments (pinout, 10 Voltage, clock
constrains etc.) and file references. The user should also make sure that the links to the files
are correct, especially for the external IP cores.

Specification 25 (34) Version 1.1



FRS Reference Design FLE&DILIS

To be able to compile the design, the user should make sure that the required licenses are
available for the Quartus tool. The license setup can be found in the Tools menu. This
Reference Design requires:

FRS (Flexibilis)
AFEC (Flexibilis)
FRTC (Flexibilis)
ALT_TSE (Altera)
NIOS (Altera)

All of these licenses are available for evaluation.

Once the QSYS system is generated and the licenses are set, the design can be compiled in
normal way. The design will generate warnings, and they should be looked thought. However,
they all should be generated by Altera blocks and should not affect the operations. In case of
suspicious warnings contact Flexibilis.

Specification 26 (34) Version 1.1



FRS Reference Design ~Le)1ibius

4 SW Reference Design

SW Reference Design is implemented as a modular design. The modules are depicted in

Figure 12.

Control
app

Protocols

Libraries

NIOS
BSP

Figure 12. SW Reference Design

The modules depicted in Figure 12 are located in separate directories under sw directory in
reference design directory.

Directory Description

xr7_softsoc_control XR7 SoftSoC Control - control application. Source code is located in
Reference Design release in FESHAOOEOQO-FBIT-
V<ver>\cyclone4GXdevkit_softsoc\sw\xr7_softsoc_control\src
directory.

xr7_ptp XR7 PTP — PTP protocol stack [3], [4]. Source code is delivered
separately and requires a license from Flexibilis Oy.

flx_redundancy_supervision | HSR/PRP Supervision protocol [2], [5]. Source code is delivered
separately and requires a license from Flexibilis Oy.

frs_management_protocol FRS Management Protocol [6]. Source code is delivered separately
and requires a license from Flexibilis Oy.

xr7_softsoc_nif Helper library, contains for example drivers for IP blocks and
controlling of SFP modules and external PHY. Source code is located
in Reference Design release in FESHAOOEQO-FBIT-
V<ver>\cyclone4GXdevkit_softsoc\sw\xr7_softsoc_nif directory.

flx_fes_lib Helper library, for accessing FRS configuration. Source code is
located in Reference Design release in FESHAOOEOQO-FBIT-
V<ver>\cyclone4GXdevkit_softsoc\sw\flx_fes lib directory.

Iwip IwlP - A Lightweight TCP/IP stack, open source. Source code is
located in Reference Design release in FESHAOOEQO-FBIT-
V<ver>\cyclone4GXdevkit_softsoc\sw\lwip directory.

frs_bsp BSP for NIOS, generated by Altera NIOS Il EDS according to
delivered configuration. Configuration is available in FESHAOOEOQO-
FBIT-V<ver>\<board>\sw\frs_bsp directory.

Table 7. SW Reference Design Modules

Source codes for protocol stacks (XR7 PTP, Redundancy supervision, FRS management
protocol) are delivered separately and they require a license with Flexibilis Oy. All protocol
stacks are included in the Reference Design release in a binary format and the functionality
can be verified using the evaluation boards.
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4.1 Modules

4.1.1 XR7 SoftSoC Control

XR7 SoftSoC Control is the main module of the system. It handles the initialization of all the
other modules and threads and performs control tasks during the execution. The source code
files are listed in Table 8.

File Description

src/xr7_softsoc_ctrl.c Main initialization and control functions. For example, initializes all
threads, scans ports, DIP-switches, updates configurations and
prints to LCD.

src/xr7_softsoc_ptp.h XR7 PTP thread handling: configuration and control.
src/xr7_softsoc_ptp.c
src/xr7_softsoc_supervision.h Flexibilis Redundancy Supervision module thread handling:
src/xr7_softsoc_supervision.c configuration and control.

Table 8. XR7 SoftSoC Control Module Files

4.1.2 XR7 PTP

XR7 PTP implements Precision Time Protocol [3]. XR7 PTP is described in detail in XR7 PTP
Design Specification [4].

4.1.3 Flexibilis Redundancy Supervision

Flexibilis Redundancy Supervision implements HSR/PRP Supervision protocol [2]. Flexibilis
Redundancy Supervision is described in detail in Flexibilis Redundancy Supervision Design
Specification [5].

4.1.4 FRS Management Protocol

FRS Management Protocol implements a proprietary management protocol for managing
FRS Reference Design. FRS Management Protocol is described in detail in FRS
Management Protocol specification [6].

4.1.5 XR7 SoftSoC NIF

XR7 SoffSoC NIF module contains drivers and other helper functions. The source code files
are listed in Table 9.
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File Description

Inc/card_if.h Definitions for Reference Design. For example GPIO mapping,
config options, etc.

inc/88e1000_ctrl.h Marwell 88e1000 PHY driver

src/88e1000 citrl.c

inc/afec.c AFEC IP (Ethernet MAC) driver [7]

src/afec.c

inc/flx_afec.h
src/flx_afec.c

inc/ethernet_input_thread.h Optional support for two level IRQ handling in Ethernet MAC.

src/ethernet_input_thread.c Enabled in card_if.h with ENABLE_ETHERNET_INPUT_THREAD
define.

inc/fes_if.h Device driver for FRS IP. [8]

src/fes_ctrl.c

inc/frtc.h Device driver for FRTC IP. [9]

src/frtc.c

inc/i2c_ctrl.h I2C bit bang device driver.

srcli2c_ctrl.c

inc/nif_ctrl.h Network stack (Iwip) initialization and helper functions.

src/nif_ctrl.c

inc/sfp_ctrl.h SFP module management and control driver. Uses 12C to access

src/sfp_ctrl.c SFP modules.

Table 9. XR7 SoftSoC NIF Module Files

4.1.6 flx_fes_lib

The library contains helper functions for managing FRS. The source code files are listed in
Table 10.

File Description
flx_fes.h Helper functions for configuring FRS IP [8]. Includes for example
flx_fes.c reading and writing of FRS registers and IPO settings.

Table 10. fIx_fes_lib Module Files

4.1.7 lwip

The library contains IwlP - A Lightweight TCP/IP stack. It is an open source TCP/IP stack. More
information can be found in Iwip documentation [10].

4.1.8 frs_bsp
Board Support Package (BSP) generated by Altera NIOS Il EDS tool.

4.2 Compilation

FRS Reference Design SW compilation is done in Altera NIOS 1l EDS. All the module sources
listed in Table 7 need to be placed under FESHAOOEOQO-FBIT-V<ver>\<board>\sw\ directory.
SW Reference Designs for different boards use the same module sources. Only frs_bsp,
which is generated by the Altera NIOS II EDS tool is board dependent.

4.2.1 Import Projects

Every SW module is implemented as a separate project in NIOS Il EDS. They have to be
imported separately and after all the projects have been imported, the application can be
compiled.

Importing steps are the following:

1. Select File->Import
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Select
E“‘u ]
Import a file from the local file systermn into the workspace,

Select an import source:

| type filter text |

[+ = General

b = GCr+

[ = CV5

[ = Git

[» = Install

4 [= MiosIl Software Build Tools Project
|@ Irmport Customn Makefile for Nios I Software Build Tools Project |
& Import Mios I Software Build Tools Project

[» == Remote Systems

i = Run/Debug

[ = Tasks

[ = Team

® | < Back |I Next > I | Einish | [ Cancel

2. From menu, select “Nios |l Software Build Tools Project” and under that selection,
select the correct import mode (discussed later).
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= Importing a custom Software Build Tools prq]n E@g
- - p—

Import the custom project folder

Folder not found

Project location:  cycloned GXdevkit_softsocswharT_ptp | Browse...

Project name: ®ril_ptp

["] Clean project when importing

Managed project

Teolchain: ’MinGW MiosI GCC4 -

@ Ned> | [ Finish | [ Cancel

3. Click Browse and select SW module directory, for example xr7_ptp. Set “Project
name:” the module name, in this example xr7_ptp, and click Finish.
4. Perform the steps 1-3 for every SW module.

In step 2, correct import type must be selected. All the protocol libraries and the Iwip-library
must be imported as “Import Custom Makefile for Nios Il Software Build Tools Project”. All the
other modules shall be imported as “Import Nios Il Software Build Tools Project”.

4.2.2 Build Application

The first step in building the application is to include all other modules as referenced projects
to xr7_softsoc_control. This can be done by first selecting xr7_softsoc_control project from
Project Explorer in the left and then selecting File->Properties.
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r B k]

type filter text Project References (=10 v -

Resource . ) )
Projects may refer to other projects in the workspace,

Builders Use this page to specify what other projects are referenced by the project.

C/C++ Build
C/C++ General Project references for wrd_softsoc_control:

Mios I Application Properti

7] =5
Project References IUC .
; - =l ndancy_supervision
Run/Debug Settings P
Task Repository bcfrs_bsp
WikiText = frs_management_protocol l
bc'lwip [

bcxr?_ptp
bcxr?_sof'tsoc_nif

Then check all the SW modules referenced in the properties window.

The next step is to generate BSP. This can be done by right clicking the frs_bsp project and
selecting Nios Il -> Generate BSP.

After this, all that is needed is to build xr7_softsoc_control project by selecting the project and
then selecting Project -> Build All. Now new xr7_softsoc_control.elf is generated.
4.2.3 Create Flash Files

New flash files can be generated with Nios || Command Shell in FESHAOOEOQO-FBIT-
V<ver>\<board>\script directory.

1. Open Nios || Command shell from Windows Start menu
2. Go to FESHAOOEOO-FBIT-V<ver>\<board>\script directory
3. Execute ./create_flash_bins.sh

Select correct options for the script according to the help. The SW option will generate only
SW update flash file and the other options will generate also FPGA configuration flash file.

4.2.4 Program Flash

New flash files can be programmed to Reference Design board with Nios Il Command Shell in
FESHAOOEOQO-FBIT-V<ver>\<board>\script directory.

1. Open Nios || Command shell from Windows Start menu
2. Go to FESHAOOEOO-FBIT-V<ver>\<board>\script directory
3. Execute ./flash_dev_board.sh

Select the correct options for the script according to the help. The SW option will program
only the SW and the other options will program also the FPGA configuration to the flash. After
programming the board, the board must be reset.
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5 Abbreviations
Term Description
AFEC Advanced Flexibilis Ethernet Controller
BSP Board Support Package
FPGA Field Programmable Gate Array
FRS Flexibilis Redundant Switch
FRTC Flexibilis Real Time Clock
HSR High-availability Seamless Redundancy
PLL Phase Locked Loop
PPS Pulse Per Second
PTP Precision Time Protocol
SFP Small Form-factor Pluggable transceiver
SoC System-on-Chip
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